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CHAPTER 1

What are the system requirements to install Astera Centerprise?

The following system requirements should be met before installing Astera Centerprise:
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CHAPTER 2

Why do we need to make two installations for Astera Centerprise?

Astera Centerprise has a client-server architecture. Centerprise’s client is a designer studio where flows and job tasks
are designed whereas the server is an execution platform for jobs and flows designed on the client. This is why we
need to make two installations for Astera Centerprise – for client and server, separately.

Read more on Centerprise installation in this document.
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CHAPTER 3

What’s the difference between Custom and Complete installation?

Incustom installation, we can choose which features we want to install and which we don’t depending on our require-
ment. Whereas in a complete installation, the whole application is installedwithout any modifications.
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CHAPTER 4

What’s the difference between 32-bit and 64-bit Centerprise?

The 32-bit Centerprise is compatible with 32-bit operating system and the 64-bit Centerprise is compatible with 64-bit
operating system.
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CHAPTER 5

Can we use a single license for multiple users?

Yes, every license has a specified number of users assigned to it, and the limit depends on the license you have
purchased.
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CHAPTER 6

Can we install Centerprise on more than one system using a single
license key?

Yes, you can install Centerprise client on more than one machine and connect it to the same server using the same
license key. However, more than one server cannot be licensed with the same key.
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CHAPTER 7

Does Centerprise client work when it’s not connected to the server?

No, for Centerprise to work, it has to be connected to a server.
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CHAPTER 8

Why do we need to build a cluster database and set up a repository while
working with Centerprise?

We need to build a cluster database and set up a repository to communicate with the server and to store informa-
tion about jobs scheduled and executed on the server. To view the jobs deployed on the server, go to Server > Job
Monitor*.***

15



FAQs, Release 7

16Chapter 8. Why do we need to build a cluster database and set up a repository while working with
Centerprise?



CHAPTER 9

Which database providers does Centerprise support for setting up a
cluster database?

Centerprise supports SQL server and PostgreSQL for setting up a cluster database.
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CHAPTER 10

How many Centerprise clients can be connected to a single server?

In the current implementation, there is no restriction on the number of Centerprise clients that can be connected to a
single server.
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CHAPTER 11

How do Centerprise client and server communicate?

Client and server in Astera Centerprise communicate on REST architecture. REST-compliant systems, often called
RESTful systems, are characterized by statelessness and separate concerns of client and server which means that the
implementation of both can be done independent of each other, if each side knows what format of messages to send to
the other.

The record of communication between Centerprise client and server is stored in a repository. Before you start using
on Centerprise, a repository must be set up to store the records of deployed jobs. Currently Centerprise supports SQL
server and PostgreSQL for building cluster databases, which can then be used for maintaining the repository. It is
where information about job logs, job queues, and job schedules are saved.
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CHAPTER 12

Is there any limit to the number of jobs that can be run on the server at a
time?

Yes, the limit on the number of concurrent jobs on a server depends on the license you have purchased.
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CHAPTER 13

Can we access help documentation from Centerprise client?

Yes, there are three ways to access help documentation from Centerprise client:

1. From the Help menu in the main Menu Bar.

1. From the question mark icon present in the Icon Bar.

2. By right clicking on any object and selecting the Help option from the context menu.
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CHAPTER 14

Up to how many servers can a single Centerprise client connect to?

A single Centerprise client can connect to only one server at a time. However, it can be configured to multiple server
servers.

27



FAQs, Release 7

28 Chapter 14. Up to how many servers can a single Centerprise client connect to?



CHAPTER 15

Why Centerprise is possibly not able to access my source file or create a
new one?

One of the possible reasons for this could be that the Centerprise Server does not have access to the directory where
you are trying to export your file or import it from.

While working with Centerprise, you must be connected to the server to execute any jobs. Centerprise client is only
used to design and submit jobs to run on the server. If the server is located on another machine, it needs to have access
to your files. This requires you to have a shared folder accessible by both client and server machines.

You can also access files from your local directory if the server is installed on the same machine as the client.
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CHAPTER 16

Will an upgrade result in the failure of existing .dlls?

No, upgrading from Centerprise 7 to 8 or from Centerprise 8.x to 8.x would not result in the failure of any existing
.dlls, and they will continue to work as before.
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CHAPTER 17

I uninstalled Centerprise from one machine and attempted to activate it
on a new device, but the server is not accepting my license key. Why am I

getting this error?

You might get this error when the license key has not been correctly deactivated from your previous machine.
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CHAPTER 18

Will I lose all my scheduled jobs when upgrading to the latest version?

Version 7 and 8 are different applications. You can have both installed on your machine and run them side by side.
When installing the version 8 client and server, you will need to build a new cluster and connect to the Centerprise 8
server. You will still be able to use version 7, so nothing will be overwritten. Also, all your models and flows created
in Centerprise v7 will work in v8.
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CHAPTER 19

Is there a way to export the existing jobs from the previous to the latest
version of Centerprise?

There are three ways in which you can export the existing jobs to the latest version of Centerprise:

1. Direct export and import of schedules from Scheduler.

2. Upgrading the 7.6 repository to 8.x. This is a required step if you previously had 7.6 installed. This option
preserves any existing schedules. To know more about it, refer to this article.

3. Upgrading 8.x to 8.3/8.4. This is a minor repository upgrade, and it adds some optimizations (indexes). This
option also preserves any scheduled jobs.
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CHAPTER 20

Is there a permanent link from where I can always have access to the
newest build?

Yes, you can always download the latest build for client and server from the following link:

http://www.astera.com/download-center/.
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CHAPTER 21

Does Astera Centerprise support data extraction from unstructured docs
or text files?

Yes, Astera Centerprise supports data extraction from unstructured docs and text file formats such as text, Excel, PRN,
and PDF files through ReportMiner.

To open a Report Model, go to Menu Bar and select File > New > Report Model.
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Click here for more information on creating a Report Model in Astera Centerprise.
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CHAPTER 22

What is the difference between full and incremental loading in database
sources?

During a full load, the entire data is processed on each run whereas during an incremental load, an Audit Field, is
specified on the basis of which, the Database source reads the incremented data only. The Incremental and full load
options can be found in properties of Database source object. For more information on full and incremental loading
options, click here.
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CHAPTER 23

Does Centerprise support extraction of data residing in online sources?

Yes, Centerprise supports the extraction of data residing in online resources. There are various built-in features such
as File Transfer Protocol (FTP) which enables users to access files from a remote directory, Email source through
which we can extract file attachments from emails, Electronic Data Interchange (EDI) which enables users to save
time and resources with its orchestration capability and REST API Browser which is used for sourcing data from an
API.
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CHAPTER 24

How is the File System Items Source used in a dataflow?

A File System Items Source is used to point towards a folder or directory containing multiple files that are to be
processed in a flow. In a dataflow, it is used when we use a source as a transformations to provide a dynamic file path
to a source object. It can be either run in singleton mode or in a loop. It requires a file path to the directory where the
source files reside. It also provides an option for including items in subdirectory which, if checked, will include all the
files present in the sub-folders

To learn more about how the File System Items Source works in using sources as transformations, click here.

File System Items Source can be found in Toolbox > Sources > File System Items Source.
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CHAPTER 25

How does the PDF Form Source differ from Report Source in
Centerprise?

The PDF form source in Centerprise is used to extract data from PDF files only, whereas the Report Source in Center-
prise extracts data from unstructured files (including .txt and PDF files) using a report model.

With Pdf Form Source, you need to provide the file path in the properties to extract your data.

However, with Report Source, first you point the path to a source file and then to a corresponding report model which
will serve as an extraction template.
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CHAPTER 26

Does Centerprise support extraction of data from EDI files?

Yes, Centerprise supports the extraction as well as integration of data from EDI files. There’s a dedicated section for
EDI data integration in the toolbox that includes features such as EDI Source File, EDI Destination File, EDI Message
Parser, and EDI Serializer. To use these features in a dataflow, go to Toolbox > EDI*.***
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CHAPTER 27

How does the Raw Text Filter option work in file sources in Centerprise?

The Raw Text Filter option is available in the Fixed Length File Source and Delimited File Source properties.
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Raw text filter is used to filter out the incoming records which you do not want to process in your dataflow. This option
is also useful in processing files that contain multiple record types. It also provides the flexibility to source selected
data by applying filters at the point of extraction, without modifying the original source data in any way. You can
choose from the following three options to filter data:

No filter. Process all records: This is the default option and it processes all the records from the source without
filtering them out.

Process if begins with: This option filters out records that start with a certain letter, digit, character, word, numeric
value or phrase.

Process if matches the regular expression: This option is useful if you want to use a regular expression to extract
matching records.
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CHAPTER 28

What does the Aggregate Transformation do in Astera Centerprise?

The Aggregate Transformation in Astera Centerprise provides the functionality to derive aggregate values from your
input data by applying aggregate functions such as Group By, Sum, Count, First, Last, Min, Max, Average, Var or
StDev. The dataset can be split into two groups so that aggregate value(s) can be generated for the group instead of
the whole dataset. For example, calculate the number of employees by city, or get average sales price by year. To use
the Aggregate Transformation in a dataflow, go to Toolbox > Transformations > Aggregate.
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CHAPTER 29

How is the Aggregate Transformation different from the Expression
Transformation?

Added again.

In the Aggregate Transformation, you can apply different aggregate functions such as Sum, Count, First, Last, Min,
Max, Average, Var or StDev and derive values from the input.
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Whereas in Expression transformation, you can apply various functions such as string, date/time, financial, matching,
logical, mathematical, regular expressions etc. on your incoming data or even write your own expressions in the
expression layout builder.
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CHAPTER 30

What are the different sorting options in the Aggregate Transformation
and how do they impact the output?

There are three sorting options found in the Aggregate Transformation properties:

• Incoming data is presorted on group by fields: In this option, aggregate transformation requires the incoming
data to be pre-arranged on the basis of “Group-by” field.

• Sort Incoming data before building aggregate: When this option is selected, the incoming data will be sorted
before applying the aggregate functions.

• Build aggregate using unsorted data: This option builds aggregate using the incoming data which may or may
not be sorted.
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CHAPTER 31

Can we omit duplicate records using the Aggregate Transformation in
Astera Centerprise?

No, but Astera Centerprise has a dedicated Distinct Transformation to filter out duplicate records from a dataset.
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CHAPTER 32

How many datasets can a single Aggregate object take input from?

The Aggregate transformation is a set-level transformation which means that it can only take input from a single
dataset. It creates derived values from input data. So, taking input from more than one source will result in cardinality
error.
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CHAPTER 33

What is an Expression Transformation?

An Expression Transformation object defines an expression or logic to process an incoming value or a set of values.
Some expressions do not depend on any user-provided input data, such as Now() which returns current date and time.
All expressions return an output value of a corresponding data type.
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CHAPTER 34

How is Expression Transformation different from the Function
Transformation?

In the Expression transformation, you can define an expression either from the library of built-in functions in the
expression builder or write your own expression. You can also modify and use variables for various calculations
in the expression transformation. Whereas in the Function transformation, you can only work with a set of built-in
functions. You cannot modify or customize these built-in functions to suit your requirement, as you can do in the
Expression transformation.
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CHAPTER 35

Does the SQL Query source support the use of parameters? If yes, how
and in what cases can it be used?

Yes, the SQL Query source in Astera Centerprise supports the use of parameters. These parameters can be specified
using a ‘$’ notation in Centerprise 7.6 and with ‘{}’ in Centerprise 8. A flow created in 7 with ‘$’ parameters will
work in Centerprise 8 but once you save it in 8, the parameter syntax will change to ‘{}’.

71



FAQs, Release 7

72Chapter 35. Does the SQL Query source support the use of parameters? If yes, how and in what
cases can it be used?



CHAPTER 36

What is a set level transformation?

Set level transformation operates on a group of records that may result in joining, rearranging, elimination, or aggrega-
tion of records. Data sources and destinations are also considered as set transformations. Generally, set transformations
operate on the entire data set. For instance, a Sort transformation sorts the entire dataset before passing records to the
next object. Similarly, Aggregate transformation uses the entire data set to construct aggregated records.

Some more examples of Set level transformations in Astera Centerprise include: Join, Route Constant Value, Distinct,
Denormalize, Normalize, Merge etc.
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CHAPTER 37

What is a Record level transformation?

Record level transformations are used to transform or augment individual fields of datasets during their movements
between set transformations. They are used to create derived values by applying a lookup, function, or expression to
the individual data fields.

Example of record level transformations include List lookup, File lookup, Expression, Sequence Generator, Switch
etc.
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CHAPTER 38

What are the different types of lookups in Astera Centerprise?

There are four types of lookups in Astera Centerprise: List lookup, File Lookup, Database Lookup and SQL Statement
Lookup.

The List lookup is the type of lookup that stores information in the metadata which means that the lookup information
is stored within the dataflow itself. You can define a list of source as well as lookup values in the lookup properties,
which are then looked up and replaced when you run your dataflow.

The File lookup is used to lookup values from an Excel or Delimited file. It can be performed based on a single lookup
field as well as a combination of fields. Similarly, a file lookup can return a single output field from a lookup table or a
combination of fields. In either case, the output field or fields are returned from the records in which the lookup values
match the incoming values.

The Database lookup is used to lookup values in a database table that contains lookup values as well as the output
values.

The DB lookup can be performed on a single lookup field or a combination of fields. Similarly, it can return a single
lookup field or a combination of them in the output. In either case, the output field or fields are returned from the
records in which the lookup values match the incoming values.

The SQL Statement Lookup works just like a Database Lookup. However, unlike Database Lookup in which we use a
database table to look up matching values, we run an SQL query to fetch matching records from the lookup table. We
can define one or more conditions by specifying the relationship between the database element and the input element
which should be fulfilled by all the incoming records. Any record which does not pass the defined condition(s) would
be discarded.
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CHAPTER 39

How is the Filter Transformation different from the Route Transformation?

The Filter transformation is used to filter out records that do not match a given condition. It does not keep any track
of records that fail to satisfy a given rule. On the other hand, the Route Transformation invokes one or more paths in
a dataflow, according to the specific decision logic(s) expressed as a set of rules. Using Route transformation, you can
create a custom logic involving multiple paths and adapt it to suit your data processing scenario.
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CHAPTER 40

Is the Filter transformation similar to Data Quality Rules in function?

The Filter transformation is similar to Data Quality Rules. However, unlike Data Quality Rules, which returns an error
or warning when a record fails to match a rule while still passing the record downstream, the Filter Transformation
will completely filter out any such records. Moreover, the filtered records as well as their status will not be accessible
to any downstream object in the dataflow, including any type of log.
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CHAPTER 41

What are the different types of Join available in Astera Centerprise?

There are four types of Join available in Astera Centerprise: Inner, Left Outer, Right Outer and Full Outer.

Inner – returns records that records that have matching values in both tables

Left Outer - returns all records from the left table, and the matched records from the right table

Right Outer - returns all records from the right table, and the matched records from the left table

Full Outer – same as Inner Join, but unmatched records from either record set are returned, and null values are written
for the unmatched record in the other record set.
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CHAPTER 42

Can we perform a Join using more than one key in the Join
transformation?

Yes, we can perform a join action using more than a one join key in the Join transformation. On the Join Transformation
Properties screen, there is an option for Left Field and Right Field where you specify the key fields from both the
incoming datasets based on which the Join action is to be performed.
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CHAPTER 43

What’s the difference between INSERT, UPDATE, UPSERT and DELETE
actions available for data loading in a Database Table destination?

Using the INSERT, UPDATE and UPSERT options, you can add individual mapping ports for respective actions,
which means Centerprise will create one mapping port for each action inside the Database Table Destination object.

The INSERT option pushes the incoming records to the destination.

The UPDATE option keeps track of the records being updated in the database table.

The UPSERT option is the combination of ‘Update’ and ‘Insert’ which means that it will check for the records that
are inserted or updated.
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88 Chapter 43. What’s the difference between INSERT, UPDATE, UPSERT and DELETE actions
available for data loading in a Database Table destination?



CHAPTER 44

What does the Truncate Table option do in Database Table destinations?

The Truncate Table option is available when we are picking an existing table to write our data, in the Database Table
Destination object. It first deletes the existing records in the selected database table and then loads the new, incoming
records in that table.
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CHAPTER 45

What’s the difference between ‘Bulk insert with batch size’ and ‘Use
single record insert’ Data Load Options in Database Table destinations?

Both ‘Bulk insert with batch size’ and ‘Use single record insert’ options are used for inserting records in a database
table. The ‘Bulk insert with batch size’ option is used when you want the whole dataset to be loaded in batches of a
specified size. Typically, larger batch sizes result in better transfer speeds. However, performance gains may be less
with relatively large batch sizes. On the other hand, the ‘Use single record insert’ option inserts one record at a time
which is relatively slower. However, any errors or warnings during the transfer are identified immediately as they arise
during the data transfer.

91



FAQs, Release 7

92 Chapter 45. What’s the difference between ‘Bulk insert with batch size’ and ‘Use single record
insert’ Data Load Options in Database Table destinations?



CHAPTER 46

How does the Default Value column in Database Table destination layout
work?

The Default Value column in Database Table destination object can be used to assign a value to replace null values in
the incoming data. It can also be used to append a constant value to your output data by creating a new field in the
layout builder just like a Constant Value object does.
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CHAPTER 47

What does the Advanced Connection Info option do in a Database object?

The Advanced Connection Info option is used to either override an existing connection settings or to set up a new
connection. For instance, to avoid connection or command timeout for heavy queries, you can override the connec-
tion/command timeout from the Advanced Connection Info. Likewise, when you want to provide SSL connection to
some SSL supported provider, you can specify this in the text box on this screen.
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CHAPTER 48

What’s the maximum number of groups we can create in Route
transformation?

In v8.2 of Centerprise, there is no restriction to the number of groups you can create in Route Transformation.
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CHAPTER 49

What is the outcome if an incoming record matches multiple rules in
Route transformation?

In Route transformation, there is an option to Follow only first matched rule in the Properties screen, as shown below.
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If the option is checked (it is checked by default), the record is assigned to the first rule it matches, even if it satisfies
more than one rule. If the option is unchecked, the record follows all the rules it can satisfy.

To learn more about this, check out this video on Routing Records to Follow Multiple Rules in Route Transformation
in Astera Centerprise.

100 Chapter 49. What is the outcome if an incoming record matches multiple rules in Route
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https://www.youtube.com/watch?v=Vv-uxgPqDOQ
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CHAPTER 50

Can we perform a hierarchical join using the Join transformation in
Centerprise?

No, we cannot. The Join transformation can only be used to join flat file formats. However, there is a dedicated
transformation, the Tree Join transformation in Astera Centerprise which you can use to perform hierarchical joins in
Astera Centerprise.
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CHAPTER 51

What is the meaning of Batch Size in Sequence Generator transformation
where a sequence is generated in a Database Table?

The Batch Size determines the length of a sequence. If a dataset contains 300 records, and the Batch Size is set to 100,
the sequence will repeat thrice since it will generate only 100 unique values and then repeat that sequence.
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104 Chapter 51. What is the meaning of Batch Size in Sequence Generator transformation where a
sequence is generated in a Database Table?



CHAPTER 52

Can we join multiple children to a single parent node using only one Tree
Join transformation object?

A Tree Join transformation object can only be used to join a parent node with a single child node. In order to join
multiple children to a parent, multiple Tree Join objects can be used sequentially.

For example, here we have Orders as the parent, and we wish to join two children, Customers and Order_Details. We
can do that by joining Customers and Orders in the first Tree Join 1, and Order_Details and Orders in the subsequent
Tree Join 2.

Visit Tree Join Transformation to learn more.
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CHAPTER 53

Which output would be assigned if a record satisfies two conditions in a
Switch transformation object?

It will assign the Output for the first matched Case Value.
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CHAPTER 54

What is the order of priority of options in different columns in the Layout
Builder of the Merge transformation object?

The priority of options in Merge transformation is from left to right, the left-most option having the highest priority
and vice versa. This means that the priority of options, from highest to lowest, is as follows:

1. Survivor Type

2. Precedence

3. Condition

4. Expression
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CHAPTER 55

What is the difference between Survivor Type and Precedence in Merge
transformation?

Survivor Type determines which data entry should remain in a particular field, such as First, Last, Maximum, Minimum,
Count, Sum or Comma Separated Values.

Whereas, Precedence decides the order of priority of the incoming data sources. For example, if there are three data
sources and the Precedence = 1, 2, 3, it means the preference of the incoming data sources is in ascending order.
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CHAPTER 56

Why does the Return All option on the Lookup Options screen in the File
Lookup transformation give an error?

The error is due to a mismatch in the cardinality of the two incoming data sources. When we select Return All in
the Lookup Options screen, it returns multiple values to write in one field, leading to a one-to-many relationship. The
change in cardinality returns an error.

To resolve this problem, flatten the data using some other transformation, such as Join or Union, before writing it to a
destination.
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114 Chapter 56. Why does the Return All option on the Lookup Options screen in the File Lookup
transformation give an error?



CHAPTER 57

If I want to have a different field delimiter, say a pipe (“|”), is there an
option to export with another delimiter and filename extension?

Yes, in a Delimited File Destination object, you can either choose a Field Delimiter from the drop-down list or specify
one according to your dataset.

115



FAQs, Release 7

Also, while exporting to a Delimited File Destination, you have the flexibility to choose whether you want to export it
in .CSV format or .txt format.

116Chapter 57. If I want to have a different field delimiter, say a pipe (“|”), is there an option to export
with another delimiter and filename extension?
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with another delimiter and filename extension?



CHAPTER 58

I want to change the output format of a column, say integer to string, or
vice versa. Any error trapping abilities with that conversion?

Yes, in Centerprise, you can change the data types of fields while exporting the data. Although you can convert the
integer data type to string data type, vice versa is only possible if your string data type is convertible to an integer data
type. Else, Centerprise will give an error and create a record level log of those erroneous records.
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CHAPTER 59

Tools Menu > Data Format has different date formats, but it doesn’t seem
to do anything. Each time I go into it, it still has the first option selected

even after choosing a different one.

This is because you can only add a new date format in Tools > Data Formats, but you cannot change any data field’s
date format. However, if you want to change the date format, you can do it while exporting your data by specifying
the format you wish to apply to your date field.
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anything. Each time I go into it, it still has the first option selected even after choosing a different

one.



CHAPTER 60

Can we export the Object Path column present in the Data Preview
window?

We cannot export the Object Path column to any destination. It only tells you the path from which the record is
coming. If your output is in a hierarchical format, it will show the course of the entire hierarchy. For example, in the
screenshot below, the data field ‘Title’ comes from the ‘EmployeesToBePaid’ object.
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CHAPTER 61

What will be the outcome if we write files multiple times to the same Excel
Destination?

In the first run, it will always create a new file and write the data to that destination. In any subsequent runs, the user
can choose how to write the file.
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If the Append to File (If Exists) option is checked, the file will be appended to the existing Excel file. If the option is
left unchecked, the Excel file will be overwritten.

If the Write to Multiple Files option is checked, the data will be written at the dynamic file path provided by the user.

For more information, check out this video on writing data to multiple files using a single destination object in Astera
Centerprise.
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https://www.youtube.com/watch?v=lksmUfaWlsM&list=PLmyM3TZtVUyKyvf75u9XUavn7T81avHrc&index=4
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CHAPTER 62

Is there a log file created that we can have written/saved to a folder of our
choice for troubleshooting purposes? Something that shows when it ran,

how many records it loaded, how many failed, and why?

Yes, you can create a record level log to capture the status (Success, Error, Warning, or Skip) for each transferred
record. You can have any number of record-level logs in the dataflow. Each record level log will capture the status of
the records in the object that it is connected to. You can also export its data afterward for troubleshooting purposes.
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many failed, and why?



CHAPTER 63

Why Database Diff Processor does not have an output node in
Centerprise v8.2?

In v8.2 of Astera Centerprise, the output node from Database Diff Processor has been removed to make it simpler to
use. It enables users to configure the database table (with which the comparison has to be made) within the Diff object
itself rather than using a separate destination object.
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CHAPTER 64

Which Database Write Strategy is more efficient for working with larger
volumes of data?

It is not the amount of data that determines which write strategy would be more efficient to work with. Rather, it
depends more on your requirement and what you want to achieve with your data. For example:

• If you want to work with dimensional data and preserve historical records, then Slowly Changing Dimension
write strategy is the best option.

• If you want to determine which records have been updated, inserted, deleted, or skipped when you are writing
to an existing file destination, the Source Diff Processor should be used in that case.

• If you want to find out which records should be inserted or updated in a database table, the Database Diff
Processor would be the more efficient write option in that case.

• If you want to take write actions based on some specific conditions, then use Data Driven Write Strategy.

Note: In Astera Centerprise 9.0, the functionality of the Slowly Changing Dimension write strategy is fulfilled by the
Dimension Loader object in the Data Warehouse section of the toolbox.
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CHAPTER 65

In which Database Write Strategy do we use a CDC file?

We use a CDC Hash file in the Source Diff Processor, whereas the Database Diff Processor relies on source CDC.
However, the CDC file used in Source Diff Processor is different than usual. Instead of incrementing the records based
on time, it captures a snapshot of the entire dataset and then compares whether the records have been inserted, updated,
deleted, or skipped.
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CHAPTER 66

How can CDC improve the performance of Database Diff Processor when
used in conjunction?

A CDC file acts as a filter that puts on a date stamp on the incoming records so that when the records are updated
again, it sends only the updated or inserted records to the Database Diff Processor. In other words, it will only pass
those records where the date is greater than that of records already stored in the CDC file. This way, the Diff Processor
only needs to identify the inserted or updated records for synchronization. Thus, resulting in improved performance.
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CHAPTER 67

Which one from the Database Diff Processor and Source Diff Processor is
a more cost-effective write strategy?

In Database Diff Processor, records are either inserted or updated based on the audit field, whereas full comparison is
made in Source Diff Processor. So, if you have a database table destination, Database Diff Processor would be used,
and in case of an Excel or Delimited destination, Source Diff Processor would be the only option.
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138 Chapter 67. Which one from the Database Diff Processor and Source Diff Processor is a more
cost-effective write strategy?



CHAPTER 68

Is it necessary for the database tables to be of same layout in order to
work with Data Driven, Database Diff Processor, and Source Diff

Processor?

The source and destination database tables do not need to be the same. Both the source and destination tables can
be from two different databases. The names of the tables can be different as well. However, for Data Driven write
strategy to work, the structure of the source and destination tables must be the same.
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CHAPTER 69

Is there any limitation to the type of source each Database Write Strategy
can take input from?

No, there is no limitation to the type of source each Database Write Strategy can take input from. However, there
is a limitation in the destination. All Database Write Strategies can only work with a Database Table destination,
except the Source Diff Processor, which can be used for writing data into any file format such as excel, delimited,
fixed-length, etc.
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CHAPTER 70

Why is it necessary to select the Single Port option in the Database Table
Destination while working with a write strategy?

While working with a Database Write Strategy, it is necessary to select the Single Port option to tell the Database
Table destination that it must follow the directive from the preceding write strategy.

143



FAQs, Release 7
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while working with a write strategy?



CHAPTER 71

Will a record be tried against the following rule if it satisfies the current
rule in Data Driven write strategy?

No. In Data Driven write strategy, if a record passes a particular rule, it will not be tried against the following rule.
Similarly, if a record does not pass one rule, it would be tried against the following rule and so on; until all rules have
been exhausted.
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CHAPTER 72

What is the difference between ‘Single Output’ and ‘One Port for Each
Action’ in Source Diff Processor?

In the Source Diff Processor, if you select the Single Port option, the database action, such as INSERT, UPDATE,
SKIP, or ERROR, will be chosen by the Database Write Strategy’s logic rather than specified by the user. Whereas, if
you select One Port for Each Action, you will get a separated node for each Diff action (INSERT, UPDATE, SKIP, or
ERROR).

147



FAQs, Release 7

148 Chapter 72. What is the difference between ‘Single Output’ and ‘One Port for Each Action’ in
Source Diff Processor?



CHAPTER 73

What is the difference between UPSERT and Database Diff Processor?

There is no functional difference between the UPSERT option in a Database Table Destination and the Database Diff
Processor write strategy. We have retained the Database Diff Processor to ensure backward compatibility for users
who have been using it.
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CHAPTER 74

Is it sufficient to use a Slowly Changing Dimension Write Strategy to
insert new records and update existing records? Or do we need to use it

in conjunction with Database Diff Processor for the purpose?

Slowly Changing Dimension is not Centerprise specific and would work the way it generally does in dimension mod-
eling. Using the Slowly Changing Dimension strategy along would suffice to update or insert records in a destination
table. You can specify the relevant SCD Type against the fields you want to insert or update in Centerprise.

Note: In Astera Centerprise 9.0, the functionality of the Slowly Changing Dimension write strategy is fulfilled by the
Dimension Loader object in the Data Warehouse section of the toolbox.
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records and update existing records? Or do we need to use it in conjunction with Database Diff

Processor for the purpose?



CHAPTER 75

How can Source Diff Processor load data incrementally?

The Source Diff Processor works differently from the traditional incremental approach. It captures an image of the
entire data. When records are updated again, it first compares them with the existing image stored in the CDC Hash
file and then loads them into the destination table.
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CHAPTER 76

What is a dataflow?

A dataflow is an XML document that defines the flow of data from the point of extraction all the way to the destination,
based on some predefined logic.

This is an example of a simple dataflow in which data extracted from an Excel source is being transformed (Sorted)
and then loaded to a delimited file destination (DelimitedDest).
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CHAPTER 77

What is a workflow?

A workflow is the visual illustration of an integration process for automated and iterative execution. It is a process
orchestrated to run a sequence of tasks such as running a program, sending an e-mail, executing some SQL query, etc.
The tasks are executed according to a pre-defined sequence, following a custom logic which decides what path must
be activated under what conditions.

You can also specify what should happen at each step if a task runs successfully or returns an error in a workflow.
You can also route the workflow by using a Boolean condition suitable to your scenario. You can even nest another
workflow or a dataflow within your workflow.

Once designed, a workflow can be deployed on the server and scheduled to run automatically as per the specified time
and frequency. To open a workflow in Centerprise, go to the menu bar at the top and select File > New > Workflow.
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Or you can open a workflow directly by clicking on the create new dataflow’s dropdown in the Icon Bar.

Click here to read more on creating and using workflows in Astera Centerprise.
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https://docs.astera.com/projects/centerprise/en/8/workflow/creating-workflows.html


CHAPTER 78

What does deployment refer to in Centerprise?

Setting up a Centerprise project to run on scheduler is called deployment in Centerprise. A deployment is made up of
a project .car file with an optional config file for parameters. To know more about how Project Deployment works in
Astera Centerprise, read here.

159

https://docs.astera.com/projects/centerprise/en/8/project-management/deployment.html#how-to-deploy-a-project-on-astera-centerprise-server


FAQs, Release 7

160 Chapter 78. What does deployment refer to in Centerprise?



CHAPTER 79

What is the difference between a Decision and OR object in workflows?

If a Decision object is connected to two Run Dataflow task objects, it will work like an AND operator, which means
it will wait for both to complete their execution and then allow the workflow to proceed further. Whereas in the same
scenario, an OR object will enable the workflow to proceed further even if one of the dataflows is executed successfully.
In other words, it works like an OR logic gate in discreet mathematics.
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CHAPTER 80

Is it possible to work with nested subflows in Astera Centerprise?

Yes. A subflow can be nested, meaning that you can call a Subflow transformation object in another subflow.
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CHAPTER 81

What is the difference between Single Instance Data Region and
Collection Data Region in Astera ReportMiner?

A Single Instance Data Region is used when the relationship between two regions is a one-to-one relationship. For
example, in a dataset of orders, an order can only be placed by one customer. Therefore, we will use Single Instance
Data Region to extract details of the customer from the data source.

A Collection Data Region is used when the relationship between two regions is a one-to-many relationship. For
example, in a dataset of orders, there can be multiple items in one order. Therefore, we will use Collection Data
Region to extract details of the items ordered.
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CHAPTER 82

How can we preview ‘x’ number of records in a Data Preview window?

You can preview ‘x’ records by specifying the number in the Source Record Count option present in the Data Preview
window. If you want to preview the entire dataset, set the Source Record Count value to zero.
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CHAPTER 83

Does the Max result rows option in Tools > Options > Query tab being
defaulted at 5000 limit the processing of any records?

In the Tools > Options > Query tab, the Max result rows option does not limit the processing of any function on your
dataset. It only limits the number of rows in the data preview to ensure higher efficiency of the preview on design time.
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CHAPTER 84

What is Pushdown Mode?

ETL (Extract, Transform, Load) and ELT (Extract, Load and Transform) are two approaches of data manipulation.
In an ETL process, the data is transformed in the staging area that is usually placed in between the source and target
systems. On the contrary, in an ELT process, the transformations take place within the target database.

In Pushdown Mode, the ELT approach is used. The Pushdown mode in Astera Centerprise enables the users to
choose where data processing happens by pushing down the transformation logic to the source or target database when
they reside on the same server. This eliminates the unnecessary movement of the data, reduces network latency by
delivering agile results and improves the overall performance.

For more information, visit Pushdown Optimization Mode in Astera Centerprise.
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